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Notes & URLs for this presentation can be found… 

» underneath the link to this slide show on 
granneman.com 

» at files.granneman.com/presentations/apple/
Getting-More-From-Your-Mac.txt



History



The Mac popularized the GUI (Graphical User 
Interface) 

1984–2001: “Classic” Mac OS 1-9 

2001–Present: Mac OS X OS X macOS



1984: The original Macintosh operating system, with an 
elegant & advanced GUI, but technically limited in 
many ways





2001: Mac OS X, a UNIX-based OS, with the attractive, 
elegant, intuitive Apple GUI running on top of it







Version Code Name Release Notes

10.0 Cheetah 2001 Mac OS X

10.1 Puma 2001

10.2 Jaguar 2002

10.3 Panther 2003

10.4 Tiger 2005

10.5 Leopard 2007

10.6 Snow Leopard 2009



Version Code Name Release Notes

10.7 Lion 2011

10.8 Mountain Lion 2012 OS X

10.9 Mavericks 2013

10.10 Yosemite 2014

10.11 El Capitan 2015

10.12 Sierra 2016 macOS

10.13 High Sierra 2017



Version Code Name Release Notes

10.14 Mojave 2018

10.15 ? 2019



Version Code Name Release Notes

10.0 Cheetah 2001 Big cats

10.1 Puma 2001

10.2 Jaguar 2002

10.3 Panther 2003

10.4 Tiger 2005

10.5 Leopard 2007

10.6 Snow Leopard 2009 Refinement of Leopard



Version Code Name Release Notes

10.7 Lion 2011

10.8 Mountain Lion 2012 Refinement of Lion

10.9 Mavericks 2013 California landmarks

10.10 Yosemite 2014

10.11 El Capitan 2015 Refinement of Yosemite

10.12 Sierra 2016

10.13 High Sierra 2017 Refinement of Sierra



Version Code Name Release Notes

10.14 Mojave 2018

10.15 ? 2019



Why a Mac?



Why do Macs “just work”? 

Apple controls the hardware and the software 

“People who are really serious about software should 
make their own hardware.” —Computer Science 
pioneer Alan Kay



Innovation 

Many things users take for granted were introduced to a 
general audience on a Mac: 

WIMP (Windows, Icons, Menus, Pointer) GUI • The 
mouse • Trackpads • Multi-touch • Sound • Drag ‘n 
drop • Friendly file names • FireWire • WYSIWYG 
printing • Multimedia • Built-in networking • Centered 
trackballs • Floppy • No floppy • Wi-Fi • Thunderbolt



Simple, understandable product line



Personal Pro Ultra-Mobile

Portable MacBook Air MacBook Pro MacBook

Desktop iMac Mac Pro Mac mini



Excellent general-purpose hardware 

…but do Macs cost more?



Personal Pro Ultra-Mobile

Portable MacBook Air 
$899+

MacBook Pro 
$1299+

MacBook 
$1299+

Desktop iMac 
$1099+

Mac Pro 
$2999+

Mac mini 
$499+

2017



Personal Pro Ultra-Mobile

Portable MacBook Air 
$999+

MacBook Pro 
$1299+

MacBook 
$1299+

Desktop iMac 
$1099+

Mac Pro 
$2999+

Mac mini 
$799+

2019



Apple’s prices beat those for comparable PCs 

Cheap PCs, however, use cheap parts, which Apple 
never uses



“But there’s some stuff in our industry that we wouldn’t 
be proud to ship. And we just can’t do it. We can’t ship 
junk. There are thresholds we can’t cross because of 
who we are. ... You’ll find that our products are not 
premium priced. You price out our competitors’ 
products, and add features that actually make them 
useful, and they’re the same or actually more 
expensive. We don’t offer stripped-down, lousy 
products.” —Steve Jobs, August 7, 2007



Uniform user interface for macOS, Apple’s apps 
(mostly), & 3rd-party apps



A Mac runs macOS, but it can also run Windows and 
Linux



It’s fun!



Computer 
Rules



Lazy is good



Take notes



Take notes













Why I use nvALT 

» Fast 
» Powerful search 
» Plain text only 
» Sync using Dropbox



nvALT 

http://brettterpstra.com/projects/nvalt/ 

$0 

Soon to be replaced by BitWriter



Other note-taking apps 

» Simplenote (OK, but nvALT is better) 
» MWeb (very good — it’s what I use on iOS) 
» Evernote (crashy; binary format) 
» OneNote (expensive; binary format; tied to 

Microsoft) 
» DEVONnote (good company; complex; $25)



Think before you click



Read the Help









Key 
Commands



Learn the key commands for macOS & your most-used 
apps 

It’s faster & more efficient



Do not to learn all these key commands at once 

Learn a few at a time that seem useful & master those, 
& then learn a few more



⌘ Command ⇥ Tab ␣ Space

⌥ Option or Alt fn Function → Right

⌃ Control ⌫ Delete ← Left

⇧ Shift ↩ Return ↑ Up

⎋ Escape ⌅ Enter (fn+↩) ↓ Down



Basics



Thank You, Scott



Can’t remember a command? 

Type ⌘⇧/ to open Help > Search 

Type a few letters, & it will show you the command



Press ⌘⇧/ …



Help > Search opens with the cursor already in the search box



Start typing the letters of the 
command you want…



Select the command, & macOS 
shows you where the command is 
in the menus so you can learn 

Press ↩ & you run the command



Cut, Copy, Paste



⌘X Cut 

⌘C Copy 

⌘V Paste 

Do not ⌘C then ⌘V then go back & ⌦—instead, use ⌘X 
then ⌘V

Your clipboard can hold any cut or copied item—text, 
image, video—but only 1 item at a time*

* You can change this with 3rd party software (e.g., Alfred)



⌘A Select all 

Very useful before using ⌘X or ⌘C



Formatting



⌘B Bold 

⌘I Italic 

⌘U Underline 

Never use ⌘U—use either ⌘B or ⌘I (ideally not both at 
the same time), but not ⌘U



Applications & Windows



⌘N New window 

⌘W Close window (or tab in Web browser) 

⌘Q Quit app 

⌘W should not quit an app, but ⌘Q closes all windows 
(although they will reappear when you reopen the app)



⌘⇥ switches between apps (→ direction) 

⇧⌘⇥ switches between apps in reverse (← direction) 

⌘` switches between windows in an app



iTerm

FirefoxWord

Word

Switch apps with ⌘⇥



Word Terminal FirefoxFinder

Keep pressing ⌘⇥ to switch apps



Word 2

Word 1

Switch windows with ⌘`



Word 1

Word 2

Keep pressing ⌘` to 
switch windows



Keyboard Maestro provides an even better Application 
Switcher than macOS does (more later!)



What are the differences between apps & windows? 

macOS is an document- & app-centric OS 
» Focus is on working on documents within apps 
» Close the final document window, the app stays open 

Windows is a window-centric OS 
» Focus is on creating, viewing, & working within 

individual windows 
» Close the final window, close the app



Menu bars for each window



1 menu bar for all documents 
within an app



Command PromptFirefox

Word 1 Word 2



Word 1 Word 2

Command Prompt Firefox Desktop

Task Switcher shows 4 windows (from 3 apps) + Desktop





Word

Terminal

Firefox

Finder



⌘M Minimize (like clicking on the     in              ) 

⌘H Hide 

Hide is better than Minimize—especially if you switch 
apps with ⌘⇥



⌘T Open a new tab in tabbed apps, or open Fonts in 
non-Tabbed apps 

Remember that ⌘W closes a tab





Open & Save



⌘O Open document… 

⌘S Save work 

⌘⌥⇧S Save As… 

⌘⌥⇧S Save As is hidden by default, & it: 

1. saves the current document 
2. creates a copy of the current document 
3. closes the current document & 
4. starts working on the new copy



Holding down ⌥ often reveals new or modified 
commands



Movement



⌘↑ Move cursor to first line (beginning) of document 

⌘↓ Move cursor to last line (end) of document 

⌘→ Move cursor to end of line 

⌘← Move cursor to beginning of line



⌥← Move left 1 word at a time 

⌥→ Move right 1 word at a time 

⇧⌥← Moves left 1 word at a time, selecting words 

⇧⌥→ Moves right 1 word at a time, selecting words



⌥⌦ Delete left 1 word at a time 

⌥⌦ Delete right 1 word at a time 

⇧⌥← Move left 1 word at a time, selecting words, then… 
⌦ Delete selected words 

Of course, you can also move right & select words 
(⇧⌥→) or select an entire line (⌘→ or ⌘←) & then delete 
with ⌦



fn↑ Move up one screen 

fn↓ Move down one screen



Deletion



⇧⌥← Moves left 1 word at a time, selecting words 

⇧⌥→ Moves right 1 word at a time, selecting words 

OR 

⇧⌥← or ⇧⌥→ to select words, then ⌦ to delete 

OR 

⌥⌦ Deletes left 1 word at a time



⌘→ Move cursor to end of line 

⌘← Move cursor to beginning of line 

OR 

⌘→ Move cursor to end of line, then ⌦ to delete 



Screenshots



⇧⌘3  
Takes screenshot of entire screen 

⇧⌘4  
Takes screenshot of selected area by clicking & 
dragging 

⇧⌘4, then Space, then Click  
Takes screenshot of selected window



Screenshot of entire screen





Screenshot of selected area





Screenshot of selected window





New in Mojave 

⇧⌘5

Invokes Screenshot, a new app that displays a panel of 
tools for screenshots & screen recordings



Capture screen

Capture window

Capture area

Record screen

Record area

Capture or start recording





New in Mojave 

⇧⌘6

Takes screenshot of Touch Bar



By default, screenshots of windows have drop shadows 
around them 

Ugly! Annoying! Unnecessary! Adds 50 px to all 4 sides! 

To change, open Terminal, type this on 1 line, & press ↩: 

defaults write com.apple.screencapture disable-

shadow -bool true

Logout or reboot — the drop shadows are gone!



Or use OnyX…





Web Browsers



⌘R Reload a webpage 

⌘L Select everything in the address bar (so you can 
type a search term or URL over it)



Others



⌘Z Undo 

⌘Y or ⇧⌘Z Redo



⌘P Print



⌘F Find 

⌘G Find again 

⇧⌘G Find again, going backwards



⌘, Open Preferences for app



Symbols



Insert symbols not found on your keyboard 

System Preferences > Keyboard > Keyboard



Check the box next to Show Keyboard, Emoji, & Symbol 
Viewers In Menu Bar



Show Keyboard, Emoji, & Symbol Viewers status menu 
appears



Character Viewer



Double-click on a character to insert it



Customize the Character Viewer



⌃⌘space opens directly to Emoji, then double-click to 
insert



Keyboard Viewer



Keyboard Viewer with ⌥ pressed



Keyboard Viewer with ⇧⌥ pressed



En dash used for ranges: June–August 6–9 p.m. 

Em dash is the proper dash: “He thought—too late—
that he shouldn’t have eaten those burritos.”

Key Combo Result Name

- - Hyphen

⌥- – En dash

⇧⌥- — Em dash



Key Combo Result Name

⌥[ “ Left double quotation mark

⇧⌥[ ” Right double quotation mark

⌥] ‘ Left single quotation mark

⇧⌥] ’ Right single quotation mark 
& apostrophe



Key Combo Result Name

⌥; … Ellipses

⌥G © Copyright

⇧⌥K  Apple



Apps



Different apps have different, special key commands 

Learn them if it will help you work faster



Keynote

Key Combo Name

⌘⌥C Copy Style

⌘⌥V Paste Style

⌘⌥P Play Slideshow



Brackets

Key Combo Name

⌘⌥S Save All

⌘⌥P Live Preview

⌘/ Toggle Line Comment

⌥⌃I Indent Document

⇧⌃J Join Lines



You can create your own key commands if needed



System Preferences > Keyboard > Shortcuts > App 
Shortcuts







Select an app 

Type in the menu 
item exactly as it 
appears (use ⌥; to 
create the ellipses) 

Select a key 
command that is 
unique in the app 

Press Add





And now we have a key command!



(I also use Keyboard Maestro to create key commands—
more on that later)



⇧



Notice what ⇧ (often) does: types an alternate to the 
pressed key(s) 

t outputs t, but ⇧t outputs T 

5 outputs 5, but ⇧5 outputs %



⌘S Save 
⇧⌘S Save As… 

⌘F Find 
⇧⌘F Find in Files 

⌘1 Collapse All 
⇧⌘1 Expand All 

Brackets



⌘R Reply… 
⇧⌘R Reply All 

⌘G Find Next 
⇧⌘G Find Previous 

MailMate



Dialog Boxes



⌘S to Save…



↩ selects

⎋ always closes

Space selects



↩ selects

⎋ always closes

Acorn



⇥ moves 
between all 
form controls 
(including 
buttons) 

Use ↑ or ↓ & 
Space to 
move & select

Acorn



⇥ moves 
between all 
form controls 
(including 
buttons) 

Use ↑ or ↓ & 
Space to 
move & select

Acorn



Space selects

↑ or ↓ moves 
between 
choices

Acorn



↩ selects ⎋ always closes

⇥ moves 
between all 
form controls, 
or groups of 
form controls 
(e.g., radio 
buttons)

Path Finder



↑ or ↓ moves 
between 
choices

Path Finder



Open/Save Dialog Boxes



Some key commands only work in Open/Save dialog 
boxes



⌘D or ⌘⇧D jumps to the Desktop 

⌘⌥L jumps to Downloads 

⌘⇧O jumps to Documents



Various key shortcuts produce a sheet that lets you 
jump to a specific folder 

Press / to start at the root of your file system 

Press ~ to start at your home folder 

Press ⌘⇧G to start with the last folder you jumped to 
(which you can of course overwrite)



 After pressing /, you start at the root of your drive  



 After pressing ~, you start in your home folder 



 After pressing ⌘⇧G, you start at the previous folder 



⌘⇧> toggles between showing hidden files & folders 
(those that begin with a .) & hiding them again



 Now press ⌘⇧>… 





⌘⌥S toggles between showing & hiding the sidebar



 Now press ⌘⌥S… 



 Press ⌘⌥S to show the sidebar again 



⌘I shows the Get Info window 

(More on that later)



⌘F jumps to the Search field & from there you can 
search your entire Mac (or stick within the folder if you 
choose that)



SnagIt

This is not an macOS dialog box!



Setting Up



System Preferences



Personal

Hardware

Networking

System

3rd Party
El Capitan



Personal

Hardware

Networking

System

3rd Party
Sierra



Personal

Hardware

Networking

System

3rd Party Sierra 
10.12.5



Mojave 
10.14.3

Personal

Hardware

Networking

System

3rd Party



Row 1: Personal



High Sierra



Mojave



Mojave





Default #1



Default #2



😐
3rd party











Find 3rd party Dynamic Desktop wallpapers 

Search for: 
free dynamic wallpaper mojave -port -windows



24 Hour Wallpaper 

58 dynamic desktops 

$6.99 in Mac App Store





El Capitan



Sierra



Sierra













El Capitan



SierraAnywhere removed



So how do you open apps that are not from the App 
Store or identified developers? 

Right-click on the app & choose Open—you only need 
to do that one time



Mojave



Mojave



Do not lose your recovery key!









Mojave



Mojave

Needed for automation!



Mojave

Access to everything, 
even protected system 
files

Backup



Backup 

» com.bombich.ccchelper 
» Carbon Copy Cloner.app 
» ChronoSync.app 
» Arq.app 

Command line access 

» sshd 
» iTerm.app

Utilities 

» HoudahSpot.app 
» CleanMyMac X 
» Drive Genius.app 
» DrivePulse.app 
» Default Folder X.app 

Apps that have Full Disk 
Access on my Mac





You can also set Do Not Disturb manually



Now scroll down…







Disable or limit 
notifications you 
don’t need



Row 2: Hardware



I keep this off because I don’t want it 
interfering with image colors



















Honestly, I think the Touch Bar is nigh useless except 
for Touch ID button on the right 

Why? I already know key commands, so having to look 
at the Touch Bar slows me way down



However, I use BetterTouchTool — software that 
enables me to program the Touch Bar (& a lot of other 
things as well!) — to make it more useful 

Still not essential to me, though 

If the Touch Bar disappeared in my next MacBook Pro, 
I wouldn’t care at all (I would be very unhappy to lose 
Touch ID though!)



I did not create this — others did



Default with BetterTouchTool

⌃ with BetterTouchTool

⌥ with BetterTouchTool

⌘ with BetterTouchTool



I got tired of typing out my email address 
(scott@granneman.com) long ago 

Apple makes it possible for you to define something you 
type which then gets expanded into something else 

For instance, if I type sem[space], it gets instantly 
converted into scott@granneman.com*

* sem is short for “Scott’s email”



Automation!





Advantage of Apple’s solution: syncs with iOS 

Disadvantage: too simple — but good for most people to 
begin with 

Solution: get something more full-featured



3rd party macro (or text expansion) programs 

» TextExpander: good but $60/year! 🙄 

» aText: good but slow to expand at times 
» Keyboard Maestro: excellent program but doesn’t 

support a lot of macros 
» TypeIt4Me: around since System 6! 
» Typinator: what I use































Typinator 

ergonis.com/products/typinator 

$28



Back to System Preferences…



Sierra





Automation!





Introduced in Lion



Triple tap on the selected words… 
(or press ⌃⌘D)























Data detectors work in many apps 

» Safari 
» Mail 
» MailMate 
» Pages 
» & many others—try it & see if it works!





Just get used to it









Row 3: Networking











Share Sheet



No Facebook?!











Row 4: System





Remove apps that say 
Unknown or that you don’t 
need running at login



If you don’t use 
fast user 
switching, 
disable this



















Row 5: 3rd Party



Sierra



Mojave



OnyX



Multi-function utility for maintenance, cleaning, setting 
parameters, & more 

Make sure you get the version of OnyX for your version 
of macOS! 

Be careful using this app!



Apple provides many hidden preferences that you can set & 
unset using the command line in Terminal 

defaults write com.apple.finder 

QLEnableTextSelection -bool TRUE

defaults write com.apple.finder 

FXEnableExtensionChangeWarning -bool false

defaults read com.apple.Finder 

NSUserKeyEquivalents

OnyX provides a GUI for those hidden preferences











Hyper Key



Caps Lock is in a prime position on your keyboard, but 
it’s pretty useless (especially with automation tools that 
will automatically ALL CAPS text for you) 

Remap Caps Lock to the Hyper key (⇧⌃⌥⌘ at the same 
time) 

Then use the Hyper key in combination with other keys 
to do all sorts of cool stuff *

* We’ll do this later





Press Hyper+L & 
make sure you get 
⌃⌥⇧⌘L 

If you do, good 
job! 

Press Cancel to 
close the sheet & 
quit System 
Preferences



Finder



Finder is the file manager for macOS 

When you look at the Desktop, you are using Finder, 
but so is using the Finder app directly



Components



Menu Bar



There’s only 1 menu bar, so if someone references a 
menu, that’s the one



 [App] File Edit View Window Help + others for each 
app



 shows you system-wide commands that are always 
available





Status menus (AKA menulets) are on the right of the 
menu bar



Holding down ⌥ on some status menus gives you 
additional info 







Holding down ⌘ allows you to move status menus 
around on the menu bar 



Tabs Tabs Tabs



Many apps already supported tabs, e.g., Chrome & 
Safari, or Finder 

Sierra enables (almost) every app to support tabs too, 
as long as the app supports multiple windows 

Holdouts? Microsoft Office



⌘T opens new tabs 

What if the app doesn’t support ⌘T (or it opens Show 
Fonts)?







😕



😕



Changing OmniOutliner with Keyboard Maestro



Changing Path Finder with Keyboard Maestro



Changing Transmit with Keyboard Maestro



Changing Safari with BetterTouchTool



Dialog Boxes



Always click on disclosure buttons







To open all disclosure boxes by default, open Terminal, 
enter the following on one line, & press ↩: 

defaults write -g 

NSNavPanelExpandedStateForSaveMode -bool true

Then do the same thing with this: 

defaults write NSGlobalDomain 

NSNavPanelExpandedStateForSaveMode2 -bool true



To check if all disclosure boxes open by default, open 
Terminal, enter the following on one line, & press ↩: 

defaults read NSGlobalDomain 

NSNavPanelExpandedStateForSaveMode

Then do the same thing with this: 

defaults read NSGlobalDomain 

NSNavPanelExpandedStateForSaveMode2

After each one, Terminal should return just this: 1



To close all disclosure boxes by default, open Terminal, 
enter the following on one line, & press ↩: 

defaults delete NSGlobalDomain 

NSNavPanelExpandedStateForSaveMode

Then do the same thing with this: 

defaults delete NSGlobalDomain 

NSNavPanelExpandedStateForSaveMode2



You can resize dialog boxes



⌘O to open a new document…



Grab & drag





Show the Finder location of a file from a dialog box



 Press ⌘R from within a dialog box… 



… & Finder opens showing the location of the file



Title Bar



Rename documents from the title bar









See all—& jump to any—of the folders that contain the 
current folder or file



⌘-click on the folder/window title





Original folder

Containing folder



⌘-click on the document title





Toolbars



Customize toolbars



View > Customize Toolbar… 

OR… 

Right-click on toolbar & select Customize Toolbar…



Finder





Safari



Path Finder



Keynote



DEVONthink



Sidebar





AirDrop



Add a link to AirDrop on your Dock 

In Finder, press ⌘⇧G

Enter: /System/Library/CoreServices/Finder.app/
Contents/Applications/ & press Enter 

Drag AirDrop to your Dock



Reorder



My order on the Finder 
Sidebar 

Based on order of use, with 
personal folders on the 
bottom



Finder Preferences



Click on the Finder icon on the Dock 

Finder > Preferences



I hide everything 
(I can see these in 
the sidebar under 
Devices & 
Shared)

I’d rather see my 
Home folder than 
All Files (which I 
find useless)



I check 
everything except 
for Movies & 
Music (I usually 
uncheck All My 
Files too) 

Note the Home 
folder is checked 
— it’s very useful



Make sure to 
show extensions 
(e.g., PDF, APP, & 
DOCX)

I don’t need 
warnings — I 
know what I did!

When I search, 
most of the time I 
want it to be in 
the current folder

For the former 
Windows users 
(not for me)



Views



Finder Views



4 Finder views

Icons ⌘1

Columns ⌘3

Cover Flow ⌘4

List ⌘2



Icons



List



Columns



Cover Flow



View Menu





View Options



Close any open Finder windows & click on your 
Desktop 

View > Show View Options





Open a Finder window that shows Downloads 

View > Show View Options







Arrange By 
organizes files 
into groups 

Sort By sorts 
files within 
groups



Quick Look

One of the best things about your Mac!



Introduced in 2007 with Mac OS X 10.5 Leopard 

Select a file & press space, & you see the contents of a 
file without actually opening it 

Press space again to close it



Viewable by default 

» AAC 
» Adobe Photoshop 
» AVI 
» BMP 
» Excel 
» GIF 
» HTML 
» JPEG 
» MP3 

» MPEG4 
» PDF 
» PNG 
» PowerPoint 
» QuickTime movies 
» RTF 
» SVG 
» TEXT 
» TIFF 
» WAV 
» Word



Open in 
default 
app

Share 
sheet



Other Quick Look plugins enable viewing of other files 

Download the plugin & place the .qlgenerator file in 
~/Library/QuickLook (if the QuickLook folder doesn’t 
exist, create it) 

Either reboot or open Terminal & run qlmanage -r



BetterZipQL: contents of 
ZIP files



MultiMarkdown 
QuickLook: rendered 
Markdown files



MultiMarkdown 
QuickLook: rendered 
Markdown files



QuickLookJSON: JSON 
files with syntax 
highlighting



QuickLookCSV: CSV files 
as tables



QLStephen: shows plain 
text files, even those 
without an extension; e.g., 
README or LICENSE



InvisorQL: video & audio 
that macOS doesn’t 
support 

AVI: Audio Video 
Interleave



InvisorQL: video & audio 
that macOS doesn’t 
support 

FLAC: Free Lossless Audio 
Codec



InvisorQL: video & audio 
that macOS doesn’t 
support 

MKV: Matroska Video File



InvisorQL: video & audio 
that macOS doesn’t 
support 

WMV: Windows Media 
Video



Other ways to invoke Quick Look besides space 

» ⌘Y 
» ⌥space to open in full screen 

Open an image with Quick Look & press ⌥ to zoom 
the image to actual size



Select 2 or more items 

Press ⌥⌘Y 

A slideshow opens with the selected items 

Close with ⎋



File Management



Select 2 or more files (or folders) 

Press ⌘⌃N & the selected files are gathered together in 
a new folder that you immediately rename 

You can also use File > New Folder with Selection 

(You can also do this with just 1 file if you want to 
quickly put it into a new folder)











Select files & folders in Finder & press ⌘C to copy them 

Press ⌘V to paste & therefore copy them to the new 
location, leaving the originals behind 

Press ⌥⌘V to move them to the new location, deleting 
the originals



File Info & Actions



Contextual Menus



A shortcut menu (also called a contextual menu) 
appears when you select a file, folder, or app & then… 

» Right-click on it 
» Hold down ⌃ & click on it



 Now press ⌥… 



Open With

Get Info

Quick Look

Copy



Get Info



Get Info shows the Info window, giving you 
information about the selected file, folder, or app 

To activate Get Info, make your selection & use… 

» File > Get Info 
» Right-click & click on Get Info 
» ⌘I



System 1.1 (1984)



System 1.1 (1984)



System 7.0.1 
(1991)



Tags for Finder 
& Spotlight

Comments for 
Spotlight

Don’t open as Retina

Allows changes to 
permissions

Permissions: Read & 
Write, Read only, No 
Access

Prevents any changes, 
including deletion,

Modified

Opened

General info



Share folder over 
a network

Number of items 
in folder



File-specific info

Change app that 
opens this file, or 
all files of this type

Change file into 
a template, & 
create a copy 
when opened 
(makes no sense 
with this PDF)



File-specific 
info

File-specific 
info,



File-specific 
info,

File-specific 
info



Inspector



Get Info is for 1 file, & the window is static 

Inspector is for more than 1 file, & the window updates 
as you add or remove files









Special Info



⌥⌘C copies the path of a file (⌘C copies the file, & the 
⌥ changes the behavior) 

Results in something like: /Users/scott/Movies/
Nosferatu (1922).m4v



Window Management



BetterSnapTool



BetterSnapTool allows you to easily set your window 
positions & sizes by dragging them to… 

» one of your screen’s corners 
» the top, left, or right side of your screen 

You can easily set your windows so they are… 

» maximized (not full screen) 
» positioned side by side 
» resized into quarters of the screen



Automation!













Demo!



www.boastr.net/bettersnaptool/ 

$3 on the Mac App Store 

If you buy BetterTouchTool instead, you can do what 
BetterSnapTool does & a lot more



Moom



Move, zoom, & resize windows 

(Yes, there is some overlap with BetterSnapTool & 
BetterTouchTool, but each does some different things)























manytricks.com/moom/ 

$10



Path Finder



Finder replacement & so much more



 Pane 1  Pane 2 

 Dual panes 



 Multiple tabs 



 Right Shelf  Left Shelf 



 Right Shelf  Left Shelf 



 Right & Bottom Shelf 



 Show Invisibles 



 Find Files & Folders 









File renamer 

Copy & Move to other 
folders 

Securely delete 

Copy & Move to other pane 

ZIP & move 

Sync folders



Email 

ZIP 

Cool plugins to do lots of 
things 

Open folder in Terminal 

Make CD/DVD 🤘







Path Finder 

cocoatech.com 

$40



ForkLife is another competitor to Path Finder 

www.binarynights.com/forklift/ 

$30



Renaming Files



Finder



Since Yosemite, macOS has the ability to rename 
multiple files (AKA, batch renaming) 

It’s very basic, but it’s enough for most people



Right-click on files or  
File > Rename n Items…











Path Finder



Of course this is built into Path Finder! 

Select files & press ⇧⌘R











A Better Finder Rename



Bulk rename files & folders



















Demo!



www.publicspace.net/ABetterFinderRename/ 

$20



Things Finder 
Cannot Do 

(& How to Do Them)



Right-Click to Create New Files



In Windows, you can right-click & create a new file 

Apple doesn’t provide a method for that 

3rd-party software does, however





30 built-in templates











New File Menu 

langui.net 

$1.99 (only on the Mac App Store)



The Dock



Spotlight



System-wide search based around an index of all items 
& files on your Mac 

Invoked by ⌘space or clicking on 🔍 status menu 

Released with Mac OS X 10.4 Tiger in 2005











Using Spotlight



A basic Spotlight search looks for files on your Mac



1990!













 Spotlight also 
searches 
inside files 



Spotlight 
with Booleans



George Boole (d. 1864), inventor of Boolean algebra (AND, OR, NOT)



Spotlight supports Boolean searches 

space (AND) 
David Bowie means David AND Bowie (the default)  

OR  
David Bowie OR Angie Bowie means (David AND 
Bowie) OR (Angie AND Bowie) 

- (NOT)  
David Bowie -knife means David AND Bowie but omit 
any results with knife









You cannot nest Spotlight Booleans, so you cannot do 
this: 

» (Mozart OR Bach) AND Concerto 
» (Mozart OR Bach) AND (Concerto OR Mass) 
» (Mozart OR Bach) AND (Concerto OR Mass) NOT 

Brandenburg



Metadata Attributes



folder: finds only folders





kind: specifies the type of items you’re searching for 

app • audio • bookmark • chat • contact • email • 
event • folder • font • history • image • jpeg • 
keynote • movie • mp3 • music • numbers • pages • pdf • 
powerpoint • preferences • presentation • 
quicktime • reminder • tiff • todo • word













by: or author: finds all items created by someone









chat: finds Messages associated with an email address





email: finds email addresses associated with your 
search term





genre: will find movies or music by genre (e.g., 
musical, comedy, rock, country) 

Based on Apple’s genres used in iTunes, but you can 
also create your own







width: & height: are based on pixels



Search term… finds items that are…

width:1440 exactly 1440px wide

width:>1440 greater than 1440px wide

width:<1440 less than 1440px wide

width:=>1440 1440px wide or greater

width:<=1440 144opx wide or lesser





date: allows you to specify timespans





duration: allows you to specify how long something is 
in seconds



Search term… finds items that are…

duration:3600 exactly 3600 seconds long

duration:>3600 longer than 3600 seconds

duration:<3600 shorter than 3600 seconds

duration:=>3600 3600 seconds or longer

duration:<=3600 3600 seconds or shorter





Natural Language 
Queries



Just type your request like you would speak to a person 
(a fairly slow-witted person, but still)





















Spotlight Suggestions

























Information















Integration 
with Other Services









Yahoo Sports





 Get local weather 



 MLB 





 Current movie playing now 





 Movie 
available 
for rent 



Conversions, 
Calculations, 
& Definitions













Application Launcher



When it comes to opening apps, do not… 

» click on the Dock 
» open Finder, then Applications, & then double-click 
» use Launchpad (pinch with thumb & 3 fingers, or 

press F4) 

Instead, use Spotlight



Looking for Sublime Text…





Looking for Keyboard Maestro…







What if you can’t remember the name of the app? 

“I can’t remember what it’s called, but I know I use it to 
track my family tree…”



 Nope… 



 Oh yeah — it’s called 
Reunion! 

 Let’s make sure this 
doesn’t happen 
again… 

 Select the file or app 
& press ⌘I (for Get 
Info)





 Wha…? 

 If a Comment matches other 
results, then the Commented 
app doesn’t appear 😡







 😃! 



Working With 
Spotlight Results



Select a result & press ↩ to open it 

Press ⌘I to open Get Info for the result



Jump directly to the definition of your search term with 
⌘L



Press ⌥ while you highlight an image result to zoom in 

Use your mouse to move around in the zoomed-in 
image



 Now press Alt… 



 Zoomed! 



 Move around with your mouse 



Jump from one section to the next (e.g. , Top Hits, 
Documents, Wikipedia, Suggested Websites, & 
Definitions) by using ⌘↑ or ⌘↓



Highlight a result & press ⌘↩ or ⌘R 

Result’s containing folder opens in the Finder



Highlight a result & press & hold ⌘ 

Result’s path appears along the bottom edge of 
Spotlight’s right panel



 Now press & hold ⌘… 





Want to search for something else? 

⎋ or ⌘⌦ clears Spotlight’s search box 

⎋ again closes Spotlight



Unhappy with Spotlight’s results? 

⌘B opens a new tab in your default browser & uses your 
default search engine to look up your Spotlight query



Spotlight Alternatives



Alfred



Spotlight on steroids 

» Search your Mac, contacts, dictionary, & the Internet 
» Calculator 
» Clipboard manager 
» Use mini player to control iTunes 
» Issue system commands 
» Run terminal (command line) commands 
» Create, download, & use workflows that do almost 

anything



Default key command for Spotlight is ⌘space 

Default key command for Alfred is ⌥space 

However, I use Alfred far more than Spotlight, but I still 
want Spotlight to be available 

Solution: switch key commands so Spotlight is invoked 
with ⌥space & Alfred is invoked with ⌘space







Demo!



Alfred 

www.alfredapp.com 

$0 or $19 for the Powerpack ($35 for a lifetime Mega 
Supporter license)



HoudahSpot



Builds on top of Spotlight with a much better 
interface 

» Far easier to conduct complex searches 
» Templates for common searches 
» Easily specify locations for scoped searches 
» Plenty of power user features

















HoudahSpot 

www.houdah.com/houdahSpot/ 

$29



System-Wide 
Features



Share Sheet



Text



Printing



Printer Dialog Box







To open Show Details by default, open Terminal, enter 
the following on one line, & press ↩: 

defaults write NSGlobalDomain 

PMPrintingExpandedStateForPrint -bool true



Printer Options



} PDF Workflows



VipRiser



I get a lot of receipts in email, & I want to quickly print 
them as PDFs to a folder that holds them all until I sort 
through them at tax time 

VipRiser is an “extensible virtual PDF printer” that 
allows you to print a PDF using a customized process







onflapp.wordpress.com/vipriser/ 

$0 

(If you have problems installing it, let me know)



Printopia









1 2



3 4



Printopia 

www.decisivetactics.com/products/printopia/ 

$20



Best Printing Trick 
Ever





System Preferences > Keyboard > Shortcuts > App 
Shortcuts



Click the + 

Application: All 
Applications 

Menu Title: Save as PDF… 

Keyboard Shortcut: ⌘P 

Press Add







To quickly print to PDF, press ⌘P ⌘P



Security



“Consider this: The Mac is the most homogeneous 
computing platform in the world. That should make it 
the most vulnerable. Instead, it has the strongest real-
world record when it comes to exploits.” —David 
Morgenstern, eWeek, June 1, 2007





Topics covered include: 

Preparing & Installing OS X • First boot • Full disk 
encryption • Firewall • Services • Spotlight • Homebrew 
• DNS • Hosts • DNSSEC • Certificate authorities • 
OpenSSL • Curl • Web browsing • PGP/GPG • OTR • 
Tor • VPN • Viruses & malware • System Integrity 
Protection • Gatekeeper & XProtect • Passwords • 
Backup • Wi-Fi • SSH • Physical access • System 
monitoring



Built-In



Gatekeeper prevents unsigned software from running 
in the first place 

Xprotect detects malware 

MRT removes malware if any is found



Gatekeeper



Introduced in Lion 10.7.5 

Allows users to restrict sources from which they can 
install apps, to reduce the likelihood of installing or 
running malware





Mac App Store 
Only apps from the Mac App Store can be launched 

Mac App Store and identified developers 
Only apps from the Mac App Store & apps signed by 
certified Apple developers can be launched (default in 
Mountain Lion & later) 

Anywhere 
All apps can be launched (default in Lion)



What if you have checked Mac App Store and identified 
developers, but you want to install software from an 
unidentified developer? 

Right-click on the app & select Open



File Quarantine (aka XProtect)



Introduced in Snow Leopard 

Anti-malware system that checks downloaded files to 
make sure they don’t contain known malware & also 
blocks any versions of Web plugins (e.g., Java & Flash) 
that have known vulnerabilities 

Periodically updated by Apple in the background





macOS warns you where an app came from



macOS warns you if a file has known malware



macOS warns you if a disk image has known malware



If malware is found, MRT — the malware removal tool 
— gets rid of it



FileVault



FileVault encrypts your entire drive with XTS-AES 128 
encryption 

Instant wipe deletes the encryption keys from your Mac 
so that the data is completely inaccessible





iCloud Keychain



Generates & stores passwords for… 

» website logins 
» credit card numbers 
» Wi-Fi networks 
» account information 

iCloud Keychain will fill in your information for you 
when you ask it too 

Everything encrypted with 256-bit AES





iCloud Keychain syncs stored, encrypted data between 
your devices: Mac, iPhone, iPad, & iPod touch



Passwords



Most people use the same password on multiple sites 

If one site gets hacked, your password for multiple sites is 
in the hands of criminals 

A lot of people put passwords on sticky notes or in text files 

They’re easy for others to see 

A lot of people choose poor passwords 

Those can be cracked in a ridiculously short time



Pick a good password 

John the Ripper & Cain & Abel (& many other tools) 
will make mincemeat of poor passwords





(Mostly bad) guidelines for a good password 

1. Don’t use easy passwords ← that one’s good advice 

2. Mix of 3 of these 4: A a 1 #  
 
3. At least 8 characters  

4. Easy to remember & hard to guess 

5. Change it every 90 days



“Your password must contain at least 8 letters, a 
capital, a plot, a protagonist with good character 
development, a twist & a happy ending.”



“The time it takes to crack a password is the only real 
way to determine its strength and value.”—Cameron 
Morris







STLCardinals



STLCardinals



STLCardinals



STLCardinals



STLCardinals



STLCardinals











Anwyccdfyawycdfyc



Anwyccdfyawycdfyc



Passphrases 
are a good thing



Use a password safe or password manager 

Generate lengthy, difficult passwords 

Securely store passwords & other sensitive data 

You only need to memorize 1 password—the one that 
opens your password safe



Here’s a method for picking a good password: 

“Where it began, I can’t begin to know when” 

Wib,Icbtkw
↓ 
W16,Ic6tkw
↓ 
W16,Ic6tkw!



Here’s a method for picking a good password: 

“Where it began, I can’t begin to know when” 

Wib,Icbtkw
↓ 
W16,Ic6tkw
↓ 
W16,Ic6tkw!



“I’m gonna fight ‘em off, 
A seven nation army couldn’t hold me back”  
↓ 
1gfe0,A7nachm6



“I’m gonna fight ‘em off, 
A seven nation army couldn’t hold me back”  
↓ 
1gfe0,A7nachm6



“Somewhere over the rainbow, way up high” 
↓ 
Sw0tr,wuh



“Somewhere over the rainbow, way up high” 
↓ 
Sw0tr,wuh



“I said a hip, hop, the hippie, the hippie  
To the hip hip-hop, and you don’t stop  
The rock it to the bang-bang, boogie say ‘up jump’  
The boogie to the rhythm of the boogie the beat.” 
↓ 
IsahhththTohhhaydsTrittbbbsupTbttrotbtb



“I said a hip, hop, the hippie, the hippie  
To the hip hip-hop, and you don’t stop  
The rock it to the bang-bang, boogie say ‘up jump’  
The boogie to the rhythm of the boogie the beat.” 
↓ 
IsahhththTohhhaydsTrittbbbsupTbttrotbtb



“Hot hot hot hot stuff hot hot hot”  
↓ 
Hhhhshhh



“Hot hot hot hot stuff hot hot hot”  
↓ 
Hhhhshhh



Lots of password managers 

1Password • B-Folders • Dashlane • Enpass • KeePassX 
• Keeper • LastPass • mSecure • Password Safe



LastPass 

lastpass.com 

$0 or $12/yr for syncing







1Password 

agilebits.com/onepassword 

Individual desktop license: $50 
Individual mobile license: $0 + $10 in-app purchase 
Teams: $5/user/month 
Families: $5/5 users/month ($1/month/extra user)























Demo!



Backup



There are 2 kinds of computer users:  

1. those who have suffered a catastrophic data failure 
or loss 

2. those who will



No backup? 

You will lose forever your papers, photos, contacts, 
music, movies…



















Online













128-bit SSL encryption during transport 

Data encryption using 256-bit AES 

New & changed files automatically uploaded 

30 day archive



Demo!



2 GB = free 

1 TB = $100/year 

www.dropbox.com



Good for backup 

Great for collaboration & syncing



If you decide to sign up, please use this link 

https://db.tt/I4EbATZ 

I get 1 GB of free space & you get an extra 500 MB!









Data encrypted during transport & in storage











www.code42.com/crashplan/ 

1 computer/$60/year 

10 computers/$150/year 

Unlimited data



Local

















Local Clone



“Disk cloning is the process of copying the contents of 
one computer hard drive to another disk … A cloned 
drive can replace the original, rather than simply 
containing backup copies of files.” —Wikipedia



Why clone? 

» Full system backup, even hidden or in-use files 
» Quickly restore a wiped drive after a security incident 

or data problem 
» Quickly upgrade to a new drive



A clone is not the same as a backup! 

A clone is only as up-to-date as the last time it ran 

A clone does not contain multiple versions of files 

A clone backs up all files on a computer







www.bombich.com 

$40 (30-day free trial)





www.paragon-software.com/home/br-free/ 

$0



Remember…



Backup locally & off-site



Automate



Encrypt



Test!



Integrating 
Windows



NTFS for Mac OS X



In order to help the computer find locations on your 
drive, you need to format it with a file system



The file system determines the exact way data is 
organized on the drive 

To the operating system, files are stored in clusters 

Each cluster points to the next cluster’s number, or 
indicates that it’s the last cluster (0xFFFF)



Since 1998, Apple has used the HFS+ (Hierarchical File 
System Plus) file system on Macs



Since 1993, Windows has used the NTFS file system 

Out of the box, Macs can read but not write to NTFS 
drives







www.paragon-software.com/home/ntfs-mac/ 

$20



Dual Booting



Install 2 (or more) operating systems on a computer 

» Windows 7 & Ubuntu Linux 
» macOS & Windows 10 
» Windows 7 & Windows 10 
» Mac OS X Yosemite & El Capitan 
» & more… 

When you turn on your Mac, you choose which OS 
you want to run



macOS includes Boot Camp, which makes it easy  
to set up dual-booting









How do you back up your Windows partition? 

WinClone 

twocanoes.com/products/mac/winclone 

$20 or $40 (to move Windows partition to a new Mac)





Dual booting is great if you need Windows to have full 
access to the hardware (for gaming or CAD or video 
editing) 

However, every time you want to use software on the 
other OS, you have to reboot 

This quickly grows tedious, although it makes sense for 
games & other apps



Virtualization



Allows users to run multiple operating systems on one 
machine at the same time



macOS—the OS installed directly on the computer—is 
the host 

Windows—& other virtualized operating systems—are 
guests 

Each guest thinks it’s the only OS running on the 
computer







Why virtualize? 

» Security 
» Easy backup 
» Run that one Windows app you have to use 
» Maximize the software you can run 
» Ease of migration 
» Testing 
» Crutch



How to virtualize 

1. Install virtualization software on your Mac (the host) 
2. Install Windows (or Linux, or…) inside virtualization 

environment 
3. Repeat step 2 as necessary 
4. Open & run guest OS’s on your Mac 

You need lots of RAM & a fast CPU!



3 choices for virtualization software on Macs 

» Parallels 
» VMware Fusion 
» VirtualBox









VMWare Fusion is good too, but recently there has 
some upheaval at the company



VirtualBox 

www.virtualbox.org 

$0 & open source 

Hosts: macOS, Windows, & Linux 

Guests: macOS, Windows, & Linux 

Not as full-featured as VMWare or Parallels, & slower



Automation



My Sample Workflow



I want a screenshot of this page, 
without the browser parts above



I press the Hyper Key so a palette of 
choices appears via Keyboard Maestro



I press S for Screenshot, which runs 
a shell script (webshot.sh) I wrote





I’m prompted to enter a name for 
the website & the screenshots



About 10–20 seconds later…



Screenshots! 

Notice how 
they’re named



Good Free Photos - wide - date: 
exactly sized for Keynote

Good Free Photos - wide - full - date: 
the entire webpage for other selections



Good Free Photos - wide - full - date.txt: 
URL of the webpage for reference



I press ⌘⇥ to invoke Keyboard Maestro’s 
Application Switcher (instead of Apple’s) & 
select Keynote



I press ⇧⌘N to create a new slide



I press ⌘⇥ to invoke Keyboard Maestro’s 
Application Switcher & select Finder so it’s 
on top of Keynote



I drag Good Free Photos - wide - date.jpg 
into Keynote



Number of automated actions: 6 

Number of manual actions: 4 

Number of times touching mouse: 1









BetterTouchTool



BetterTouchTool allows you to configure… 

» gestures for your Magic Mouse, MacBook Trackpad, 
& Magic Trackpad (1 & 2) 

» mouse gestures for normal mice 
» actions for keyboard shortcuts 
» actions for normal mice buttons 
» & a lot more!























Demo!





BetterSnapTool’s features are being rolled into 
BetterTouchTool 

BetterSnapTool will still be available as a lightweight 
tool focused on window snapping 

If you buy BetterSnapTool, you will get a free license for 
BetterTouchTool



www.boastr.net 

Pay what you like: $4.49–$50



picatext



Easy OCR of short passages of text





Press ⌘⌥⌃P









Demo!



www.picatext.com 

$4 on the Mac App Store



Hazel



System Preference pane that watches folders & then 
automatically file, organizes, & cleans files in those 
folders

















Demo!



www.noodlesoft.com 

$29



Keyboard Maestro



Create keyboard macro shortcuts that can automate 
just about anything 

Launch apps • Click the mouse anywhere • Execute 
scripts • Insert text • Position windows • Flow control 
with loops & conditionals • Press buttons • Select 
menus • Open files & URLs • Move, copy, rename, & 
trash files • Create & work with unlimited clipboards • 
Save & paste clipboard history • Control iTunes • 
Display notifications • Find & manipulate images • 
Switch between apps



Trigger macros based on almost anything 

Hot keys • Click on macro palette • Status menulet • 
Typed strings • When an app launches, quits, activates, or 
deactivates • System clipboard changes • Keyboard 
Maestro engine launches • Window changes focus • Log in 
to your Mac • Hard drive is mounted or unmounted • 
Periodically while logged in • System goes to or wakes 
from sleep • Time of day • USB device is attached or 
detached • Connects to, or disconnects from a wireless 
network • Triggered from iPhone, iPad, or iPod Touch • 
Scripts



One of the most complex but also most powerful apps 
you can use on your Mac



Select menus









Display text in window







Insert text & type keystroke





I press the Hyper Key so a palette of 
choices appears via Keyboard Maestro, 
& then press O



KM presses ⌘L to select the address bar, 
then types in http://codepen.io/
pen/?editors=110 & hits Return



Block key command from working





Execute AppleScript





Execute shell script & paste results





Execute external shell script









Activate apps, run commands, & insert text









Select menus & click & drag with mouse











Conditionals





Enhanced Application Switcher









Demo!





www.keyboardmaestro.com 

$36



Thank you! 

scott@granneman.com 
www.granneman.com 
ChainsawOnATireSwing.com 
@scottgranneman
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Changelog 

2017-09-20 1.5: Combined naming charts in History; 
fixed minor formatting issues; added Thank You, Scott 
(⌘⇧/) to Basic Key Commands; added Terminal 
commands for disclosure buttons; added Show the 
Finder location of a file from a dialog box; added 
screenshot of Finder sidebar; added command for 
QuickLook slideshow; added Special Info in Finder; 
updated Mac prices for 2019; 



Changelog 

2018-08-19 1.4: Added File Info & Actions section 
under Finder with Contextual Menus, Get Info, & 
Inspector; added HoudahSpot under Spotlight; added 
commands to open all disclosure boxes & Show Details 
for printing; added File Management section with New 
Folder with Selection; applied Granneman 1.4 theme; 
fixed minor formatting issues; added Sidebar under 
Components; more info on built-in security; added 
⌘⌃D in addition to triple-click for data detectors



Changelog 

2017-09-06 1.3: Fixed formatting; in History, added 
High Sierra; in Key Commands, added Alfred for 
clipboard; added slides re: holding down ⌥ in Open & 
Save; made deleting clearer in Movement; added slide 
about drop shadows in screenshots; added huge 
amount about Path Finder; added slides re: Finder 
renaming files; added lots of examples of Spotlight 
searches (RIP David Bowie); added New File Menu; 
added duration:, date:, & much more to Spotlight



Changelog 

2016-10-11 1.2: Changed Lazy is Good image; spread 
Automation throughout the deck; renamed Things You’re 
Not Doing Right to Finder & added lots more; added 
Spotlight section; changed menulets to status menus; 
added Quick Look 
2016-10-07 1.1: Changed theme; fixed formatting; added 
& changed a lot; new stuff on Finder, Printing, Key 
Commands, System Preferences, Tabs; added Computer 
Rules section; lots of fixes 
2016-03-13 1.0: First version
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